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PeopleSearch Overview

The overview contains brief information about PeopleSearch and Web Active Directory. To get started
installing and using PeopleSearch in your organization, go to the Quick Start Guide.

About PeopleSearch

Web Active Directory's PeopleSearch™ product empowers you to take control of the information in your
Microsoft® Active Directory®. With a clean, intuitive user interface, PeopleSearch enables users to find
information about other users, computers, printers, groups or just about anything else in your
organization, as long as the data come from Active Directory.

The v3.4 release adds editing features in PeopleSearch and allows administrators to use secondary
search pages with highly customized layout templates to edit Active Directory attributes that are stored
by distinguished name, including Manager, Assistant and Group Members. See the release notes for more
detailed information about enhancements made in this release.

Features and Benefits

e  Search and export Active Directory data from a user-friendly web interface.

e Target user views using tabs for functional departments, office locations or different
management levels in your organization

e  Support multilingual offices within your organization with localization capabilities
e Report and mine audit data from your Active Directory to satisfy auditing requirements

e Navigate your organization using a visual org chart using the manager/employee relationships
as stored in your Active Directory

e Delegate tab visibility to end users or groups using access control lists

e Display employee photos stored on your network and linked to your organizational users' Active
Directory attribute values

e  Administer PeopleSearch with a clean, simple web-based interface

e Use powerful LDAP search filters to control exactly what data displays and filter out disabled
accounts, display groups, computers, etc.

e Search and export an entire Active Directory Forest from one web interface as PeopleSearch
supports multiple domains within the same forest through its support of Global Catalog
searching

e  Export data from Active Directory to Microsoft Excel®

About Web Active Directory LLC

Web Active Directory LLC, a provider of web-based Active Directory management tools, develops its
products on the Microsoft .NET technology platform. Web Active Directory's products leverage the
powerful .NET framework to deliver consistent, reliable and scalable web applications to your enterprise.

Microsoft and Active Directory are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.






PeopleSearch Quick Start Guide

You can install PeopleSearch and get it running very quickly, in many cases in less than 20 minutes. This
guide helps you walk through the pre-installation, installation, post-installation and configuration steps to
easily set up PeopleSearch and have it operating in your environment. Before you begin using
PeopleSearch to search your Active Directory, you should complete the steps in this guide to properly
install and configure PeopleSearch. Contact Web Active Directory support if you need assistance with any
of the steps.

Verifying Prerequisites

PeopleSearch requires that your installation server and web browser clients meet a few important
requirements to successfully run the application. These requirements include certifying the web server's
operating system version, web server version and ASP.NET version. Refer to the Verify Prerequisites
topic for more information about exactly what requirements your system must meet to install and run
PeopleSearch.

Installing PeopleSearch

Once you ensure your system meets the PeopleSearch requirements, you can install the PeopleSearch
software on the web server that will run PeopleSearch. Refer to the Installation topic for more
information about how to install PeopleSearch on a web server.

Searching your Active Directory

You are now ready to search your Active Directory using PeopleSearch. You can open the Search Console
from the Web Active Directory PeopleSearch menu item in the web server's Programs menu. You and
your users can also access PeopleSearch by entering http://<MyWebServerName>/PeopleSearch/ into a
web browser.

Note: Your web server configuration may differ from a normal installation depending on the
virtual directory name you selected or if you have moved files to another application, etc. Please
contact Web Active Directory support if you would like assistance diagnosing an issue with
connecting to the PeopleSearch Search Console.

After you try out the default PeopleSearch configuration using the Search Console, refer to the individual
topics related to the types of administrative operations you need to perform to customize your
PeopleSearch application for your environment. You might first want to restrict who can access the
PeopleSearch Administration Console and you should refer to the Administration Console topic for more
information about securing your Administration Console.

Typically, you will want to configure the branding of PeopleSearch to match your company and you can
set up a new logo and application titles using the Branding page. You will also usually set up Windows
groups from your domain and then create access control lists to control tab viewing using the Security
page. You can change your page layouts and what attributes display on each page using the Task Nav
page. Use the Attributes page to configure which attributes are available in each tab and to create drop-
down lists that restrict the searchable data values that display in the Search Console.

Refer to the Administration Console topic for detailed information about what each Administration
Console page allows you to configure in PeopleSearch.






System Requirements & Support

System Requirements

You should ensure your environment meets the following requirements before installing PeopleSearch.

Server Requirements

Ensure the server on which you will install PeopleSearch meets the following requirements before
installing the application.

Server Hardware 500 MHZ Pentium III and higher, 128MB RAM, 50MB free disk space

Server Operating Windows Server 2003 or later

System

Web Server Internet Information Services 6.0 or later (Windows Server 2003 ships with
IS 6.0)

ASP.NET .NET 2.0 only; you can download and install the free Microsoft .NET framework

from http://msdn.microsoft.com/netframework/downloads/howtoget.asp.

Active Directory Windows 2000 schema or later

Domain Requirements

The forests and domains you intend to search and update must meet a couple of requirements to run
PeopleSearch.

Active Directory Microsoft Active Directory 2000 or later (mixed or native mode)
Active Directory Read permissions for end-users on the Active Directory attributes you intend
Permissions to expose as searchable in the PeopleSearch application.

Client Requirements

Client browsers that connect to PeopleSearch, including the Search Console for end-users and
Administration Console for administrators, must meet two requirements or PeopleSearch will not work
correctly.

Client-side Client-side scripting must be enabled. Scripting typically is enabled by default

scripting in the browser but your organization may have overridden the default script
settings using domain group policy or individual users might have overridden
their script settings.

Cookies Cookies should be enabled. This is not a critical requirement as it only affects
one minor feature of the application and if a browser does not allow cookies
the state of the org chart (whether it shows or hides) will not be saved at an
individual end-user level.

Checking if Client-Side Scripting is Enabled for a Browser

These procedures illustrate how to check for client-side scripting for Microsoft Internet Explorer browsers.
Please refer to your browser's documentation for information about enabling client-side scripting if you
are using a non-Internet Explorer browser.

Checking for client-side scripting with Internet Explorer 7.x:

1. Select Internet Options from the Tools menu.
2. Click the Security tab.
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3. Select Internet from the list of security zones at the top of the Security options dialog box.
4. Click Custom Level.
5. Scroll to the Active Scripting item under the Scripting section.
6. Select Enable.
7. Click Ok to exit the Security Settings dialog box.
8. Click Ok to save your changes from the Internet Options dialog box.
Checking for client-side scripting with Internet Explorer 6.x:
1. Select Internet Options from the Tools menu.
2. Click the Security tab.
3. Select Internet from the list of security zones at the top of the Security options dialog box.
4. Click Custom Level.
5. Click Settings.
6. Scroll to the Active Scripting item.
7. Select Enable.
8. Click Ok to exit the Security Settings dialog box.
9. Click Ok to save your changes from the Internet Options dialog box.
Checking for client-side scripting with Internet Explorer 5.x:
1. Select Internet Options from the Tools menu.
2. Click the Security tab.
3. Select Internet from the list of security zones at the top of the Security options dialog box.
4. Click Custom.
5. Click Settings.
6. Scroll to the Active Scripting item.
7. Select Enable.
8. Click Ok to exit the Security Settings dialog box.
9. Click Ok to save your changes from the Internet Options dialog box.
Checking for client-side scripting with Internet Explorer 4.x:
1. Select Internet Options from the View menu.
2. Click the Security tab.
3. Select Internet from the list of security zones at the top of the Security options dialog box.
4. Click Custom.
5. Click Settings.
6. Scroll to the Active Scripting item.
7. Select Enable.
8. Click Ok to save your changes.
Support

For your support needs, you can check our support knowledge base or open a support ticket via email or
telephone.

Accessing the Web Active Directory Knowledge Base



System Requirements & Support

You can access our knowledge base at http://support.webactivedirectory.com.

Opening a Support Ticket

The support mailbox and telephone is monitored from 7:00 AM to 6:00 PM Mountain Time USA (GMT - 6)
from Monday through Friday. We try to respond to all support inquiries within four hours on Monday
through Friday during these core support hours. You can make arrangements for support outside of
these core hours by contacting Web Active Directory support at support@webactivedirectory.com.

To open a support ticket via email:

1. Create an email message to support@webactivedirectory.com.
2. Include the following information about your case in the email.

e  Operating system and service pack level of the server where PeopleSearch is installed

e  Whether the server where PeopleSearch is installed is a domain controller (we highly
recommend you *do not* install the product on a domain controller but we will support
this configuration if it is your only option)

e LDAP Base Path variable from the Directory page of the Administration Console
e  Error message or behavior your are experiencing
e Application event log from the server where PeopleSearch is installed

e  WADETrror.log file from the server where PeopleSearch is installed, typically C:\Program
Files\WebActiveDirectory

3. Send the email with the requested information and you should receive a confirmation
message soon with further information that a ticket has been created.

To open a support ticket via telephone:

1. Call Web Active Directory Support at +1 800.747.3565.

2. Prepare the following information about your case to relay to support personnel or leave in your
voice mail message.

e  Operating system and service pack level of the server where PeopleSearch is installed

e  Whether the server where PeopleSearch is installed is a domain controller (we highly
recommend you *do not* install the product on a domain controller but we will support
this configuration if it is your only option)

e LDAP Base Path variable from the Directory page of the Administration Console
e  Error message or behavior your are experiencing
e Application event log from the server where PeopleSearch is installed

e  WADError.log file from the server where PeopleSearch is installed, typically C:\Program
Files\WebActiveDirectory

Knowledge Base

You can access a comprehensive knowledge base addressing common issues and configuration questions
at http://www.webactivedirectory.com/.

Information

If you would like more information about Web Active Directory LLC, please contact us at
info@webactivedirectory.com.

Sales

For sales or purchasing questions, please email the Web Active Directory sales team at
sales@webactivedirectory.com.
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Licensing and Maintenance

The licensing and maintenance notes here provide high-level information about Web Active Directory's
licensing and maintenance agreements for PeopleSearch . Please contact your Web Active Directory
account executive for information about your particular licensing scheme and maintenance agreement.

How is PeopleSearch licensed?

PeopleSearch is typically licensed on a per user basis. The user count is based upon the number of
employees in your company with an LDAP account, including user accounts and contacts. In most
Microsoft Active Directory environments, each employee has a user account stored in Active Directory.

Web Active Directory LLC recognizes that each organization is different and many have unique
environments that do not fit the standard organization. Please contact your Web Active Directory account
executive to discuss licensing options if you do not feel you fit the standard model for licensing.

If you have questions regarding your licensing or use of PeopleSearch, please contact Web Active
Directory LLC.

How do | register my PeopleSearch serial number?

PeopleSearch requires a serial number to operate properly. You can register your serial number by
choosing the Licensing option from the left navigation menu of the Administration Console. Once
registered, your software will run based upon the type of licensing enabled by the serial number.

Refer to the Licensing topic for more information to register your software.

Am | eligible to receive support and product updates?

Web Active Directory LLC provides email and telephone support in addition to product updates to
organizations that possess current maintenance contracts. While under a current maintenance contract,
upgrades are free. Support is provided via email and telephone as well as through an online support
knowledge base.

You can access the support knowledge base at http://support.webactivedirectory.com/ and it is free and
available for all customers, including those with no maintenance contract in place. Please contact your
sales representative if you have a questions about your maintenance contract.



Installation

Verify Prerequisites

Ensure the server on which you will install PeopleSearch meets the following requirements before
installing the application. You can check the full list of system requirements at System Requirements.

Server 500 MHZ Pentium III and higher, 128MB RAM, 50MB free disk space

Hardware

Server Windows Server 2003 or later (Service Pack 2 is preferred)

Operating

System

Web Server Internet Information Services 6.0 or later (Windows Server 2003 ships with IIS
6.0)

ASP.NET .NET 2.0 only; you can download and install the free Microsoft .NET framework

from http://msdn.microsoft.com/netframework/downloads/howtoget.asp.

Active Directory Windows 2000 schema or later

Checking Product Versions

You may need to check the version of certain products you are using to verify they meet the
PeopleSearch requirements.

Internet Information Services

Each operating system Microsoft produces maps to a version of IIS and you have IIS 6.0 if you are
running Windows 2003.

Windows Server IIS 7.0 (IIS 7.5 for R2)
2008

Windows Server I1IS 6.0
2003

ASP.NET

Go to the Microsoft Knowledge Base article at http://msdn2.microsoft.com/en-
us/netframework/aa569264.aspx to check if you have version 2.0 of the .NET framework installed on
your web server. If you do not have it installed, the article contains instructions about how to download
and install version 2.0.

Installation

Before you install PeopleSearch, ensure you verify that the installation server meets the prerequisites to
properly install PeopleSearch. Once you have satisfied these requirements, you can install PeopleSearch
with confidence.

To install PeopleSearch on your web server:

Log in to your web server.
2. Locate the installation package you downloaded from Web Active Directory's download site and
open it.

3. Refer to the PeopleUpdate_InstallationGuide.pdf document in the package for detailed
instructions on installing PeopleSearch, including upgrading from previous versions of
PeopleSearch.
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PeopleSearch Resource Files

PeopleSearch installs several files on your web server's file system to enable the application to run
correctly. By default, these files install themselves at C:\Program Files\WebActiveDirectory\ and the
installer grants the proper permissions to the ASP.NET account. You can change the resource file location
during the installation process, though, and you must ensure that the ASP.NET account, typically the
IIS_WPG security group on Windows Server 2003 and typically the IIS_IUSR security group on Windows
Server 2008, has Modify permissions on the directory in which the PeopleSearch resource files reside.
Ensure you lock permissions down for other users, though, so unauthorized users cannot access and
modify these resource files.

WebADConfiguration.xml Stores the configuration data for your custom PeopleSearch
configuration as XML

WebADError.log Logs error information for errors and other issues that occur in
PeopleSearch and support personnel can use this file to help
troubleshoot application problems; this error information is also
entered into the Application event log

WebADTrace.log Contains application tracing information when tracing is enabled

LdapMapping.xml Maps friendly LDAP attribute names to their true directory
names in Active Directory

WebADLocalizationTemplate.xml Provides a template for you to use to localize your PeopleSearch
application tabs

Post Installation

PeopleSearch requires no post-installation procedures and you can run the product as soon as installation
completes.

Uninstall

You can uninstall PeopleSearch for application upgrades, to repair it or to completely remove it from your
system. The uninstallation process leaves your configuration settings and files for partial uninstallations
related to upgrades and repairs while the full uninstallation completely removes all PeopleSearch files
and settings.

To remove PeopleSearch for an upgrade or repair:

1. Open the Add/Remove Programs applet from the Start > Control Panel > Add or Remove
Programs menu.

Locate the WebAD PeopleSearch program in the list of installed products.
Select Remove or Uninstall and confirm the uninstallation by clicking Yes.

4. The uninstaller leaves your current PeopleSearch settings on the system. When you run the
repair or upgrade installation, the process will detect your settings and leave them so your
repair or upgrade will use your current settings.

To completely remove PeopleSearch:

1. Open the Add/Remove Programs applet from the Start > Control Panel > Add or Remove
Programs menu.

Locate the WebAD PeopleSearch program in the list of installed products.
Select Remove or Uninstall and confirm the uninstallation by clicking Yes.

4. After uninstallation completes, navigate to the application root folder where PeopleSearch is
installed--typically in the Program Files\WebActiveDirectory\PeopleUpdate directory--and delete

10
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the PeopleUpdate root directory and all files in the directory. This will remove all residual
PeopleUpdate files from your system.

11






Configuration & Administration

Administration Console

The PeopleSearch Administration Console provides a web-based user interface to manage virtually every
aspect of your PeopleSearch application in one centralized place. PeopleSearch uses ASP.NET forms
authentication for the Administration Console and you can change the password for the administrative
user to something secure in your environment. Use the Administration Console's Security page to change
the administrative user password. Refer to the Securing the Administration Console topic for more
information about controlling access to the PeopleSearch Administration Console.

Logging Into the Administration Console

You can access the PeopleSearch Administration Console to manage your PeopleSearch configuration.
The console employs forms authentication that uses an administrative account with encrypted credentials
that are stored in the PeopleSearch configuration file. Check out the Securing the Administration Console
topic for instructions to change the administrative user password. You can also configure PeopleSearch to
use Windows authentication and there are contact Web Active Directory support if you want to configure
PeopleSearch this way.

To log in to the Administration Console:

Open a web browser.

2. Navigate to http://<YourServerName>/<YourVirtualDirectory>/AdminPage.aspx, where
<YourServerName> is the name of the web server on which you installed PeopleSearch and
<YourVirtualDirectory> is the virtual directory into which you installed PeopleSearch.

3. Log in to the Administration Console using the correct administrative user credentials. In a
default installation, the user name is Administrator and the password is PeopleSearch. Please
note that the password is case sensitive. You can change the password once you log in by
navigating to the Security page. Refer to the Securing the Administration Console topic for more
information.

4. View the Administration Console home page and navigate to the administration pages you need
to configure your PeopleSearch installation.

Securing the Administration Console

You can secure the PeopleSearch Administration Console for your environment by changing the password
for the administrative user. PeopleSearch leverages ASP.NET forms authentication to check the
administrative user's credentials and authorize access to the Administration Console. The administrative
user's password is encrypted and stored in the PeopleSearch configuration file and you can change it
using the Administration Console's Security page.

To change the Administration Console administrative user password:

1. Log in to the Administration Console. Click here for more information about logging into the
Administration Console.

Click Security in the left navigation bar in the Global Configuration section.

In the Administrator Account Configuration section, type in the old password and then enter the
new password and confirm it.

Note: If you cannot remember the old password, you can reset the password to a default value
using the procedure in the Resetting the Administrative User's Credentials topic.

4. Click Save Changes to update the administrative user's password. You will use the new
password the next time you log in to the PeopleSearch Administration Console.

13
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Resetting the Administrative User's Credentials

You might need to reset the PeopleSearch administrative user's credentials if you change the password
and then forget it. This procedure allows you to reset the administrative user's name and password to
their default values.

To reset the PeopleSearch administrative user's credentials:

1. Navigate to the PeopleSearch configuration directory on the web server where you installed
PeopleSearch. This directory is by default located at C:\Program Files\WebActiveDirectory, but
may be in a different location depending on your environment. You can look up the location in
the Windows registry at HKEY_LOCAL_MACHINE\SOFTWARE\WebActiveDirectory\PeopleSearch
in the ConfigFilePath value.

Back up the configuration file before you make any changes

Open the configuration file with a text editor like Notepad. You can also use an XML file editor if
you have one available and this will make it much easier to edit the file.

4. Locate the <appAdministration /> element under configuration/securityConfig/appSecurity.

5. Ensure the encryptionKey attribute value is set to "3ncrypt" and remember that this value is
case sensitive so you should ensure the case matches. Change this value to "3ncrypt" if it is
something different.

6. Locate the <appUser /> element under the <appAdministration /> element.

Set the userName attribute value to "Administrator" and set the password attribute value to
"60StZhhGZ7SdydxR0O80xZw==" and you should probably paste the values in to ensure data
accuracy.

Save the configuration file.

Go back to the Administration Console and log in with a user name of Administrator and a
password of PeopleSearch. The password value is case sensitive.

Administration Console Pages

The Administration Console contains pages that allow you to quickly and easily configure your
PeopleSearch application for your environment. PeopleSearch administration comprises two primary
configuration scopes: global configuration and tab-specific configuration. The global configuration applies
to elements that impact application behavior the same way across all tabs. Tab-specific configuration
elements only impact the tab under which they are configured. This flexibility allows you to create a
robust application configuration that satisfies myriad business scenarios.

Admin Home Page

This page acts as the home and default page for the Administration Console and contains a brief
overview of each of the Administration Console's pages and what they allow you to configure in
PeopleSearch. The Admin Home page loads by default when you initially log in to the Administration
Console.

Global Configuration Pages

The Global Configuration section includes two configuration pages: Branding and Security. The Branding
page allows you to customize your PeopleSearch interface to include your corporate logo and colors as
well as to personalize the title of the PeopleSearch application. Use the Security page to set up access
control lists that can include Windows groups from your environment and you can then use these access
control lists to determine which tabs users can view.

The configuration pages in the Global Configuration section control settings for your entire PeopleSearch
application across all tabs and you cannot apply these settings to specific tabs since the configuration
affects all tabs the same way.

Licensing Register your license serial number and check the current license status

14
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Branding Customize the PeopleSearch user interface site title, localization file, banner and style
sheet

Security Set global directory bind information and proxy account credentials. Manage groups
and access control lists that control which tabs your users can view

Global Set global directory bind information and proxy account credentials for searching and

Directory updating your Active Directory, add default search filters and set directory search
parameters

Global Configure which attributes are available for global page layout templates and set

Attributes display options for attributes

Page Manage page layout templates used by secondary pages

Layout

Templates

Secondary Manage secondary pages used to search for update values for attributes stored by

Pages distinguished name (DN)

Tab Configuration Pages

PeopleSearch uses tabs to allow you to easily search your Active Directory by dividing it into more
manageable configurations. Each tab can be configured to work with different parts of your Active
Directory and you can also control which users see which tabs to further secure information for viewing.
Each tab can bind to a different part of the directory and have its own set of attributes and pages. You
can even subdivide tabs into task items that can show different information available on each tab!

The Tab Configuration section includes four configuration pages: Tabs, Directory, Attributes and Task
Items. The Tabs page allows you to manage the tabs that appear in your PeopleSearch interface. The
Directory page helps you configure Active Directory connection and binding information. Use the
Attributes page to set up which LDAP attributes, also known as fields, are available to pages in the tab as
well as how the attributes display. Finally, the Task Items page allows you to configure and lay out
individual task items and pages for the tab.

As you use the pages in the Tab Configuration section of the Administration Console you will notice a
"matrix" navigation feature that make it easier for you to navigate among all the different configurations
you can create with tabs and task items. When you are on a selected tab, you will always view each
Directory, Attributes or Task Items configuration within the scope of the selected tab. As you view the
configuration page and change settings, note the tab you are editing is highlighted at the top of the
page. To edit a different tab, just click on the tab you want to edit and you will switch to that tab’s
configuration settings. In a similar manner, as you switch among Directory, Attributes and Task Items
configuration pages you will notice that the highlighted tab stays the same among the pages. This allows
you to quickly set up the directory, attributes and task nav configurations for a particular tab.

The same type of behavior characterizes how pages behave as you switch tabs. The selected
configuration page remains highlighted as you switch among tabs and displays the tab's configuration for
that page. This allows you to easily change configurations for multiple tabs.

The configuration pages in the Tab Configuration section control settings for your each PeopleSearch tab
and settings on one tab do not affect the behavior of other tabs.

Tabs Create or delete tabs, set up localization for a tab and set the access control list that
determines who can see each tab

Directory Set directory bind information and proxy account credentials for searching and
updating your Active Directory, add default search filters and set directory search
parameters

Attributes Configure which attributes are available for Task Items pages and set display options
for attributes

Task Manage page flows, create page display layouts and set advanced configuration

Items options for task items

Global Configuration

15
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Administration Console: Branding Configuration Page

Customize the PeopleSearch user interface using the Branding page to manage the site title, localization
file, banner and style sheet. The settings on the Branding page apply to your entire PeopleSearch
application across all tabs.

Accessing the Branding Configuration Page

You must have administrative access to the PeopleSearch Administration console to modify branding
settings.

To navigate to the Branding page:

1. Log in to the Administration Console. Click here for more information about logging into the
Administration Console.

2. Click Branding in the left navigation bar in the Global Configuration section.

Setting Site Information

You can modify the site titles that appear in the application banner and on the browser's title bar to fit
your organization.

Site Title Title text displayed on each page under your web site banner

Browser Title Text that displays in the browser's title bar at the top of your browser

Bar Text application

Localization File File path to the global localization file to use for the application. This localization

Path file acts as the default global localization file. Individual tabs can have their own
localization files and tab-level localization files override the global localization
file.

No Data Found Text that displays on the Detailed Results page when an object cannot be found

Message in the directory. This issue most commonly occurs when the web application

security settings for the product are incorrectly configured in IIS. In this
scenario, the My Info tab cannot locate the account for the authenticated user
and will then display this message. In general, the message displays on the
Details page when the item about which you want to display details cannot be
located.

Link Options User Display Name: Check this option to display a linkable user name in the
welcome text in the upper-left part of the Task Nav of the Search Console.

E-Mail Addresses: Check this option to create linkable e-mail addresses for any
attributes that display an e-mail address. You can override this option at an
attribute level on the Attributes management page.

URIs: Check this option to create linkable URIs for any attributes that display
URI. You can override this option at an attribute level on the Attributes
management page.

URI Target: Set the default target for linkable URIs displayed in the Search
Console. You can use the default HTML options of "_blank," "_parent," "_self" or
"_top." You may also enter a name for a window and all links will target the
same new window.

To modify site title settings:
1. Navigate to the Administration Console’s Branding page.
2. Edit the Site Title and Browser Title Bar Text fields.
3. Click Save Changes to update your PeopleSearch branding configuration.

Localizing the Application Across All Tabs

16
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PeopleSearch allows you to localize your PeopleSearch installation. You can provide a default localization
file that will set the text on all Search Console pages in all tabs and these localizations override the
default application text. This is a good configuration if you'd like to customize your Search Console and
provides a default display for tabs that do not override the global localization file you set up on the
Branding configuration page. You might want to use this feature if you are a multi-national corporation
operating offices in locations that speak multiple languages. You can then expose PeopleSearch to each
office in their native language and consolidate administration to one PeopleSearch instance instead of
managing multiple application distributions.

PeopleSearch localization works by reading an XML file that contains the localized text for the display
elements in the application. You can put the XML localization file anywhere you’d like where the
PeopleSearch web server can access it and you can create multiple localization files for PeopleSearch.
Web Active Directory recommends that you store the localization files outside of the PeopleSearch
installation directory so the files are not overwritten during product upgrades. All you need to do is set
the localization file path to the location where you saved the file.

If you do not set a localization file or if the file cannot be located for the configuration then the entire
application will use the default language implementation of U.S. English. Individual tabs can override the
global localization file to allow you extensive customization of the user interface from tab to tab.

To set a global localization file:
1. Navigate to the Administration Console’s Branding page.

2. Enter the path to your localization file in the Localization File Path field. You may enter the path
using any path descriptor that allows PeopleSearch to find the file, including a local path on the
web server like C:\MyLocalizationFile.xml, using a UNC path like
\\MyServer\MyShare\MyLocalizationFile.xml and using HTTP like
http://MyServer/MyVirtualDirectory/MyLocalizationFile.xml.

3. Click Save Changes to update your PeopleSearch localization configuration.

Changing the banner settings

PeopleSearch allows you to customize the banner image that displays so you can seamlessly integrate
the application into your corporate software environment.

Banner HTTP path to the banner to display at the top of each PeopleSearch page. For

Path example, if your banner image is stored at
http://www.mycompanyname.com/images/YourCompanyLogo.gif, then enter the
entire previous URL to the image. We recommend that you store your custom banner
image outside the virtual directory installed with the application to ensure the image
isn't deleted or overwritten when you upgrade to newer versions. You can also use
the default banner image located at
http://<YourServerName>/<YourVirtualDirectory>/Images/Branding/WadBanner.gif,
where <YourServerName> is the name of the web server on which you installed the
application and <YourVirtualDirectory> is the virtual directory into which you
installed.

Note: You can also use a relative path to reference your image using the form
/<YourVirtualDirectory>/Images/YourImage.gif.

Banner Displays a preview of the banner image you specify in Banner Path when you save

Preview the configuration changes

Alternate Text displayed when a user hovers his or her mouse over the banner image

Text

Banner Forces the banner image to the width you specify; if you set this option to zero (0)
Width for width, it will display the image at its native width

Banner Forces the banner image to the height you specify; if you set this option to zero (0)
Height for height, it will display the image at its native height

To modify banner settings:
1. Navigate to the Administration Console’s Branding page.

2. Make the appropriate changes to the Banner Path, Alternate Text, Banner Width and Banner
Height fields.

3. Click Save Changes to update your PeopleSearch branding configuration.
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Customizing the style sheet

PeopleSearch uses Cascading Style Sheets (CSS) technology to store display formatting for the Search
Console. You can copy the default style sheet from the ~/Styles directory in the PeopleSearch application
installation directory and customize the style sheet for your organization. You should copy the style sheet
to a location outside the PeopleSearch installation directory to ensure you customized style sheet will not
get overwritten when you upgrade PeopleSearch.

Style Sheet HTTP path to the style sheet you want use. For example, if your style sheet is

Path located at http://www.mycompanyname.com/styles/YourStyles.css, then enter
this for the path value. Alternately, you can use the default style sheet located at
http://<YourServerName>/<YourVirtualDirectory>/Styles/MainStyle.css.

Note: Do not make changes to the default style sheet as these changes will be
overwritten when the application is removed or upgraded. Instead, copy
MainStyle.css outside of the virtual directory, make your changes, and then point
the style sheet path to the new location. This will ensure the style sheet is not
removed or overwritten when you upgrade to newer versions.

Display Table Sets the width of each column for data displayed on the Detailed Results and

Cell Width Edit pages in the Search Console. The width, defined in pixels, determines how
wide each column of data displays. Set the width to 0 to expand the column
width to the width of any data displayed in the column. You can use this value
when you change the behavior of the Details button from the Summary Results
page and you need to limit the width of the data.

To set a custom style sheet path:
1. Navigate to the Administration Console’s Branding page.
2. Enter the path to your customized style sheet in the Style Sheet Path field.
3. Click Save Changes to update your PeopleSearch branding configuration.

Administration Console: Global Security Configuration Page

The PeopleSearch Administration Console's Security page allows you to manage groups and access
control lists that control how users can interact with PeopleSearch. You can employ the access control
lists you create using the Security page to show tabs to certain groups of users.

Accessing the Security Configuration Page

You must have administrative access to the PeopleSearch Administration console to modify security
settings.

To navigate to the Security page:

1. Log in to the Administration Console. Click here for more information about logging into the
Administration Console.

2. Click Security in the left navigation bar in the Global Configuration section.

Understanding PeopleSearch Security

To control access to functionality, PeopleSearch uses access control lists to determine which users can
access certain areas of the application. An access control list consists of a set of one or more groups
whose membership dictates the users who are part of the list. These groups include built in PeopleSearch
groups like SELF and MANAGER as well as Windows groups from your domain.

You will need to add groups from your domain to the PeopleSearch security configuration and then create
access control lists with those groups. Refer to the section below for more information about how to
create access control lists in PeopleSearch.

Built in PeopleSearch Groups

PeopleSearch includes two built in groups that you can include in your access control lists: SELF and
MANAGER. These special groups compare the current authenticated PeopleSearch application user
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against the users viewed in PeopleSearch and determines the group(s) in which the authenticated user is
a member based upon the authenticated user's relationship to the user being viewed in PeopleSearch.

Built In Description Scope
Group
SELF Refers to the current user account accessing the Single user

PeopleSearch application working with her own
user account in the Detailed Results, Edit or
Account Management pages. Compares the
current user against the user displayed in the
Detailed Results pane.

MANAGER Refers to the current user account accessing the All users reporting to a
PeopleSearch application and includes working particular manager (direct
with the chain of direct reports and descendants in reports only and does not
an organizational hierarchy as defined by the include all users in the chain
Manager relationship in Active Directory. of command)

Compares the current user displayed in the
Detailed Results page to determine if the user
viewing the results is the Manager of the user
being displayed.

For example, if the user accessing PeopleSearch is SAMPLEDOMAIN\AnyUser, this user has a SELF
relationship to the AnyUser account in Active Directory. In a similar fashion, AnyUser has a MANAGER
relationship to any direct reports for AnyUser.

Configuring User Authentication

PeopleSearch retrieves information about the authenticated user from Active Directory. This operation
requires searching Active Directory to find details about the authenticated user. The User Authentication
Configuration options control how the user information is retrieved from Active Directory.

User Authentication Configuration

The User Authentication Configuration allows you to configure the search parameters to retrieve Active
Directory information about the authenticated PeopleSearch application user. If the search does not
return results for the authenticated user based upon the parameters defined here, the application will
load an empty user and some application functions may not work correctly.

LDAP Bind LDAP bind path to the root of the container in which you are searching for

Path authenticated user informat. The path should start with LDAP:// (in capital letters
as this value is case sensitive) and the path indicates to PeopleUpdate where to
bind to the directory to execute searches.

Note: If you leave the LDAP Bind Path blank it will automatically try to locate a
domain controller in the domain using the LDAP://RootDSE bind path, which is the
default bind path that binds to the well-known root DSE object. If the
authenticated user is still not found, the application will search the root of the
forest using the Global Catalog.

Account Account used to search Active Directory. The account needs Read access to all
Name objects and attributes in Active Directory you want to search when authenticating
a user.

Example Proxy Account: YOURDOMAIN\PeopleSearchServiceAcct or
PeopleSearchServiceAcct@yourdomain.local

Note: For pre-windows 2000 accounts, account names can only be 20 characters
long and are truncated at the 2-th character. You will need to truncate the
account name you enter here if it is longer than 20 characters and you are using
the NETBIOS form of the name. If your domain and account name are longer than
20 characters, use the UPN format of accountname@domain as a best practice.

Password Password for the account
Check for Indicates that PeopleSearch should search for a linked External Associated
External Account (EAA) for the authenticated user. The EAA is linked through the
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Associated msExchMasterAccountSid attribute on a user's mailbox in an Exchange Resource
Account Forest.

See the article at http://www.msexchange.org/tutorials/Understanding-External-
Associated-Account-Windows-Server-2003-Exchange-2003.html for more
information about External Associated Accounts.

Using Windows Groups for Access

You can use security and distribution groups from your domain to control access in PeopleSearch. The
groups you add to the PeopleSearch security configuration can be included in access control lists that you
can apply to tabs to allow groups of users to view the tab. You must add groups to the configuration
before you can create access control lists using the groups.

To add a Windows group:
1. Navigate to the Administration Console’s Security page.

2. Enter the name of the Windows group in the Group Name field in the Group Configuration
section. Ensure you qualify your group name properly by including the domain with the group in
the form of MYDOMAIN\Group.

3. Click Add Group to add the group to the security configuration.
Using Access Control Lists to Manage PeopleSearch Security

Access control lists help you determine who has access to PeopleSearch functionality including tab
viewing. You must apply access control lists to tabs to hide them from certain users.

Creating and Changing Access Control Lists

Access control lists include groups whose members are also members of the access control list.
PeopleSearch uses access control lists to control security to application functionality including tab
viewing.

You can set up as many access control lists as you need to satisfy the unique needs of your organization.
Each access control list should have a set of related groups whose members need to perform similar
operations in PeopleSearch.

To create an access control list:
1. Navigate to the Administration Console’s Security page.

2. Enter a descriptive name for the access control list in the Access Control List name field in the
Access Control List Configuration: Attribute Editing section.

3. Click Add Access Control List to add the access control list to the security configuration.

Once you create an access control list, you need to add groups to it. Refer to the Adding a Windows
group topic for more information about how to create groups to use to add to an access control list.

To change the name of an access control list
1. Navigate to the Administration Console’s Security page.

2. Click Edit next to the access control list with the name you want to modify in the Access Control
List Configuration: Attribute Editing section. This will put the access control list into edit mode.

3. Modify the name in the Access Control List Name field.

4. Click Save ACL to save your changes.
Managing Groups in an Access Control List

Access control lists use group membership to determine who has access to PeopleSearch functionality.
You can add and remove groups to and from an access control list to change which users are members of
an access control list. You can also change the name of an access control list without affecting how it
controls security access in the application.

To add groups to an access control list:
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Navigate to the Administration Console’s Security page.

Click Edit next to the access control list that contains the groups you want to modify in the
Access Control List Configuration: Attribute Editing section. This will put the access control list
into edit mode.

Select the name of the group you want to add to the access control list in the Group list.
Click Add Group to add the group to the access control list.

Add as many groups as you need to the access control list.

Click Save ACL to save your changes.

To remove groups from an access control list:

1.
2.

Navigate to the Administration Console’s Security page.

Click Edit next to the access control list that contains the groups you want to modify in the
Access Control List Configuration: Attribute Editing section. This will put the access control list
into edit mode.

Click the X icon next to the group you want to remove from the access control list.
Remove as many groups as you need from the access control list.

Click Save ACL to save your changes.

Tab Configuration
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